
 

985 University Avenue ● Suite 5 ● Los Gatos, CA ● 95032 

Buffer Management with PS8.5 

 

1. Introduction 
The goal of this document is to describe some of the new features, fields and reports specifically designed for Buffer 
Management with Sciforma PS8.5. 

In this new release, Sciforma offers several new fields to allow a better buffer management based on a dynamic 
recalculation of the buffer duration and buffer incursion. The buffer color determination, traditionally based on three 
equal thirds, is now originated from a new formula called Buffer Color. In this document, we will describe how this 
formula works and can be customized to adapt to your buffer management needs. 

PS8.5 is capable of generating several types of graphs to help monitoring buffer incursion across time. In order to 
generate these graphs, we will need to understand how to capture historical data on a project using new Field 
Logging feature of PS8.5. 

2. Installing PS8.5 
• All the previous capabilities of PS8 are maintained in this new version. 

• If you are upgrading from PS8.1.x, the install program will allow you to keep your previous installation of PS8 
and install PS8.5 in separate directory. That way, you can keep your current settings and test the new features 
before “going into production”. All the fields and reports we will use in this document are available in the 
PS8.PSC provided with PS8.5 

• C:\Program Files\Sciforma\PS8.5 is the default path if you opt for a separate installation or if you are not 
upgrading your copy of PS8. 

• If you choose to install PS8.5 by overwriting your current PS8 installation, the setup program will NOT 
overwrite your current PS8.PSC located in C:\Program Files\Sciforma\PS8. That way, you will not loose your 
current configuration Data by upgrading to PS8.5. However, in this case, you will need to load manually the 
new configuration data containing the fields, formulas and reports on the top of your existing PSC. You can do 
so by: 

• Opening the BackupPS8.PSC file located in C:\Program Files\Sciforma\PS8 and merging it with your 
current PSC file. This will add the new configuration data, but may also overwrite some of your existing 
configuration data that have the same names. For instance, if you edited an existing report without giving it 
a different name, the report will be overwritten by the one contained in the backupPS8.PSC 

• Opening the PS8.5_CCPM.PSC file provided with this document. This file contains a subset of the 
configuration data required for generating the new critical chain reports and graphs. Attention, this file 
might as well overwrite some of your configuration data, such as existing filters, formulas, etc. 

Before you proceed with any of these options, we recommend that you make a backup copy of your current 
PS8.PSC file or any other .PSC file your are using. That way, you can reopen it and merge it with the new PSC file. 

 

How to merge configuration data? 

1. Form PS8, choose File / Open 

2. Change the Files of type to Configuration (*.PSC) 
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3. Select the configuration file you want to open, the Configuration Data to load Dialog box will appear: 

 
4. Select or deselect the data category in the left pane and the category members in the corresponding right pane. 

Note that a [Will overwrite] indication will be shown if the category member you are loading already exist in 
your current configuration file. 

5. Save your updated PSC file by choosing File / Save All 

 

For the remaining of this document, we will assume that you either have installed PS8.5 in a separate directory, or merged the 
BackupPS8.PSC file into your existing file. 

3. Understanding the Buffer Incursion Guide 
In order to illustrate the Buffer incursion Guide concept, we will use a very simple example of a critical chain 
project. 

You can recreate this project with PS8 or open the CCPM_0.PSP provided with this document. If you choose the 
second, make sure you place the ResList.PSR file in the same folder as the project file so it will be loaded at the 
same time. 
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In this project, the Project Buffer uses the 50% duration calculation method, the first Feeding Buffer (#10) uses a 
50% Safety Removed and the second Feeding Buffer (#11) has been calculated using the Sum of Squares. 

The Buffer Incursion field is displayed to the right of each buffer. The Buffer incursion Guide is displayed next to 
the Safe Duration field. The project is in Tracking Mode and Baseline 1 is saved. 

Update #1 

 
5 days have been completed on Task A. The remaining duration for Task A is now 15 days and the remaining 
Critical Chain length is 35d. If we were to reinsert the project buffer now, using the same exact method, we would 
only need a 17.5d long project buffer. This value is dynamically calculated by PS8 every time you update the project 
plan. It’s called the Buffer Duration Guide. 

The Buffer Incursion Guide is the difference between the Buffer Duration and the Buffer Duration Guide.  (2.5d 
in this example is 20d – 17.5d). 
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If the Buffer Incursion Guide is a negative value, you are definitely using too much of your buffer! However, it is 
important not to conclude too fast that a 0d or a positive value of the Buffer Incursion Guide corresponds to a 
“good” buffer incursion. All of this must be related to the buffer duration and the remaining length of the chain. 
Let’s look at the next update… 

 

Update#2 

 
 

Another 5 days are completed on Task A and the remaining duration is increased to 15d. The Buffer Incursion 
Guide shows 2.5d (20 – 17.5). Even if we have the same Buffer Incursion Guide value as in Update#1, the situation 
is not as good. We have used 5d of our buffer and we should have only used 2.5d to be on track. 

On Task B, 5 days have been used and the resource has requested another 5 days of work to be able to finish the 
task. As a result, the Feeding Buffer is totally used. The Buffer Incursion Guide shows 0d since the Remaining 
Chain is equal to the Original Chain length. 

The Buffer Incursion Guide and the Buffer Duration Guide can be only updated because PS8.5 remembers how a 
given buffer was calculated in the first place. This information is stored in the new Buffer Calc Method field. For 
buffers inserted with a previous version of PS8, the Buffer Calc Method is obviously unknown and set to 
“Uninitialized”. The only way to take advantage of the Buffer Incursion Guide for these “old” projects is to dissolve 
the existing buffers and insert them back into the plan using the same original method. However, this operation 
involves going back to the planning mode and you will loose the current buffer incursion. 

We encourage you to look up for Buffer Incursion Guide, Buffer Duration Guide and Buffer Calc Method in the PS8 
Help Index for more details on these new fields.  

It’s now time to introduce the Buffer Color formula of PS8. 

4. Understanding the Buffer Color formula 
In the previous versions of PS8, the color corresponding to the buffer status was only based on the % of Buffer used. 
A “green” color corresponded to a buffer incursion of less than 30%, “yellow” for an incursion greater than 30% and 
less than 50% and “red” for a buffer incursion greater than 50%. 
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In PS8.5, the buffer color formula now takes into account, the Buffer Incursion, the Buffer Incursion Guide and the 
buffer duration to assign a status color to the buffer. 

Note that, for projects created with a previous version of PS8, the buffer color will still be generated using the 
%Buffer used field only. However, we changed the thresholds in the formula to reflect three equals thirds (0.33-
0.67) instead of 30% and 50%. We will later explain how to edit these values to reflect your choices for buffer 
monitoring. 

The Gantt chart now displays the Buffer Color Task formula to the left of each Buffer bar. 

  
 

Below is the raw text of the Buffer Color formula. Our purpose here is not learn how to build such a formula, but to 
describe what parameters can be changed to adapt the formula to your buffer management approach. The colors will 
help us to decompose the formula and analyze it’s content. 

If (Buffer Calc Method ="Uninitialized", If(% Buffer Used <= 0.33,"Green",If(% Buffer Used > 
0.67,"Red","Yellow")),If(Buffer Incursion <= Buffer Incursion Guide,"Green", If(Buffer Incursion Guide<0, If( (( 
Buffer Incursion Guide / Duration )  -  ( Buffer Incursion / Duration) ) *(-1) >.10,"Red","Yellow"), If( ( Buffer 
Incursion / Duration)  -  ( Buffer Incursion Guide / Duration )  >(.10),"Red","Yellow")))) 

 

If (Buffer Calc Method ="Uninitialized", If(% Buffer Used <= 0.33,"Green",If(% Buffer Used > 
0.67,"Red","Yellow")), 

 This portion of the formula is to take into account “uninitialized” buffer created in a previous version of 
PS8. You can change the thresholds simply by editing the value “0.67” and “0.33”. 

If(Buffer Incursion <= Buffer Incursion Guide,"Green" 

 This portion of the formula is to return a “Green” value if the Buffer Incursion is less or equal to the Buffer 
Incursion Guide. 

   

If(Buffer Incursion Guide<0 

This condition will return “Red” for negative Buffer Incursion Guide values. 
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If( (( Buffer Incursion Guide / Duration )  -  ( Buffer Incursion / Duration) ) *(-1) >.10,"Red","Yellow"), If( ( Buffer 
Incursion / Duration)  -  ( Buffer Incursion Guide / Duration )  >(.10),"Red","Yellow")))) 

This condition will return “Red” for a variation greater than 10%. Otherwise, a Yellow status will be returned. 
Another way to describe the Buffer Color Formula, is to look at the following graph: 

 

 

 

 

 

 

 

If you wish to change the 10% threshold to another value, simply edit the “.10” values underlined in the above 
portion of the formula. 

 

Buffer Color  

110%

100%

0%

5. Capturing Historical Data 
Now that we know what is the Buffer Incursion Guide and how the status colors are generated, we need be able to 
capture the information in order generate a time-based chart. 

Choose Define/Field Logging… to display the Logs dialog box. 

2 Logs are available by default in the PS8.PSC provided with PS8.5: Buffer History Log and Milestone History Log. 

You can create additional Logs to track any Project or Task Level fields, but for now we will only use the Buffer 
History Log. For a detailed explanation on how to create additional logging scenario, look up for “Creating a new 
field logging scenario” in the PS8 on-line help. 

To capture the current values defined in the Buffer History Log, make sure the Buffer History Log Scenario is 
highlighted and then click the Capture button: 

 
The date displayed in the Log capture dialog box is always Today’s date, assuming your computer’s system date is 
the current date. You can adjust the capture date if necessary. 

Phone: 800.533.9876 ● Fax: 408.354.0122 ● Email: sales@sciforma.com 

Web: http://www.sciforma.com 



 

985 University Avenue ● Suite 5 ● Los Gatos, CA ● 95032 

Once you clicked the OK button, PS8 save the log values into a spreadsheet view that you can display by clicking 
the View… button.  

Note:  

• All the data captured will also available in the Report Writer. 

• The Buffer History Log captures data required for generating both the Buffer Incursion Graph and the Buffer 
History Graph. No changes should be done to the log. 

6. Generating the Flash Buffer Incursion Graphs 
Flash Graphs are web-based documents and therefore they need to be created using PS8’s Web Site Manager. The 
graphs are created based on the data displayed in the following PS8 reports: 

• [Flash] Buffer History Graph (Monthly) (Requires matching XML) 

• [Flash] Buffer Incursion Graph (Monthly) (Requires matching XML) 

• Etc. 

You do not need to edit these reports in the PS8 Report view. The Flash plug-in will build the graphs based on the 
data contained in the report.  If you do not have Macromedia Flash Player already installed on your machine, you 
can download the latest version directly from Macromedia at: 
http://www.macromedia.com/software/flash/download/ 

In the following example, we will demonstrate how to generate the Buffer Incursion Graph (weekly). Just follow the 
same method for generating other Flash type of graph. 

In the Define Menu, choose Web Site… 

In the Web Site dialog box click the New… button  

 
Define the name and root directory for the web site. If you are going to automatically transfer the graphs to a web 
server, you will need to define the FTP connection parameters in the Options tab. 

In the Layout tab of the Web site manager dialog box you need to create at least one folder, then insert the 
appropriate reports. 

Click the Insert Folder… button, and type-in a name for the folder 
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Click the Insert report… button and select both the following reports: 

• [Flash] Buffer Incursion Graph (Weekly) (Requires matching XML) 

• XML Incursion Report (Weekly) 

 
If you insert any of the Flash reports, you will need to insert the matching XML report as above. However, you can 
hide the XML report so it doesn’t appear on the Web Site after it’s generated. 

 To hide the XML report, check the Show Advanced Layout Fields option, scroll to the right and set the Invisible 
option to Yes as in the following example: 

 
Click OK to close the Web Site Manager dialog box and click the Generate button to create the Web site. 

It’s now a good idea to save your configuration file by choosing Save All in the File menu.  

Phone: 800.533.9876 ● Fax: 408.354.0122 ● Email: sales@sciforma.com 

Web: http://www.sciforma.com 



 

985 University Avenue ● Suite 5 ● Los Gatos, CA ● 95032 

Once the web pages have been produced, you will need to retrieve the Index.htm file located in the Web site root 
directory you defined earlier. Using your Browser, click the hyperlinks to load the Buffer incursion Graph. 

The following example has been produced after capturing the Buffer History Log for each week of the project and 
generating the above Web Site example. You should be able to reproduce this graph by opening the 
CCPM_Completed.psp 

  
 

By default, all the Buffer Incursion Graph reports use a 10% threshold to determine the Yellow portion in the graph. 
You can easily change this threshold by editing the cell in the XML Incursion Report. 

For instance, in PS8, select the Report View with the XML Incursion Report (Weekly) 

Double click on the report to display the Format Report dialog box and double click the cell containing " 
cthreshhold="10"/>. Edit the value as needed. 
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7. Supporting Files 
 Buffer Management Files – PS85_BM_Files.zip 

 Buffer Management PSC File – PS85_BM_PSC.zip  
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